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GeoConcept 
 
In IIMS, the Geoconcept was introduced as a tool to manage and analyze Geographic 
information. The Geographic information to deal with IIMS includes digital maps, 
statistical data, urban planning data, utility data and so on. The following items were 
considered to introduce the GIS Software. 
 

1) Applicable for data inputting, thematic mapping, production of evaluation map and 
output of maps. 

2) To include the practical and user-friendly modules 
3) High operability as a business support tool 

 
As the DTGC and the DUA have introduced the GeoConcept, they have already prepared 
the digital maps by using it. These organizations are using these digital maps for various 
purposes. 
 
 
(1) DTGC 

They apply the GIS to update and manage the digital maps, and undertake map 
management and provide map information services to the user.  

 
(2) DUA 
 They add urban planning data to the digital maps, and produce the thematic maps by 

using GIS. 
 
 
The goal to prepare the manual 
 
If the study team consider the fact that the DTGC and the DUA use the GIS at the present, 
the GeoConcept software was selected. This software shall be upgraded from an 
operational level to a practical level. This manual is arranged to include the necessary 
items in producing the final products for IIMS and contains especially the operational flow 
that is not included in the software manual, and the functions that have not been applied 
yet. The following items are included. 

1) General flow of basic operation 
2) Definition and setup of coordinate system 
3) Data acquisition and compilation 
4) Application of raster data and data acquisition from raster data 
5) Import and export of data 
6) Import of existing data 
7) Compilation of database and preparation 
8) Correction of attribute data by using query function 
9) Application of SQL/ODBC and link of them 

10) Data analysis 
11) Query and representing functions 
12) Spread sheet analysis tabulation 
13) Thematic mapping by virtual layer 
14) Topological operation  
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15) Grouping 
16) Buffering analysis 
17) Management for documents 
18) Output of maps 
19) Application of GeoExplorer 
20) Some problems of Import and Export in GeoConcept 
21) Data conversion in IIMS 

 
 
 

1. General operation 
The general flow from the preparation of files to map output will be described below.  
(See Fig.1.) 

 
(1) Preparation 
 - Examination of the methodology of data entry, map arrangement for data entry, 

preparation of the overlay maps, selection of GCP, etc. 
- Checking of georeference parameters in map. 
- Definition of data structures such as Polygon, Line, Point and Text.  
- Definition of database such as data type, data length, coding, design of Relational 

Database, etc. 
 

(2) Data entry 
 -  Definition of map projection. 
 -  Setup the UTM projection in Senegal.  
 -  Definition of map area. 
 -  Definition of type and subtype for data entry including fields in database. 
 
(3) Data Entry and Edit about figure data 
  Selection of the methodology for data entry as follows: 

1) Tablet digitizing 
2) Raster digitizing 
3) Importing and editing from existing data. 

The topological data structure for map editing is always considered for data entry.  
Pay attention that the features must be digitized along the boundary of polygons 
and lines. 
 

 (4) Attribute data entry and editing in database 
 - Linkage of figure and database. 
 - Arrangement and coding of attribute data in database 
 - Use of relational database 
 - Design of database form 
 
(5) Production of thematic map 
 - Production of thematic map by data query and display. 
 - Production of thematic map from the classification map by the use of virtual layer, 

etc. 
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(6) Data analysis 

 - Data analysis and tabulation by data query.   
 - Overlay by the topological operation  
 - Grouping of thematic maps by category. 
 - Buffer analysis 
 - Form management 

 
(7) Production of output 

  
(8) Data Export 

 
(9) Usage of GeoExplorer 
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Preparation 
  Examination of the methodology of data entry, map arrangement, definition of data 

structures such as Polygon, Line,Point and Text.  Definition of database such as data 
type, data length, code, design of Relational Database, etc. 

 ↓ 
  Map arrangement such as preparation of the draft map for data entry, the traced map, 

selection of GCP, etc. 
 ↓ 
  Data Entry or data editing 
      New data entry  →  Editing from existing data 
 ↓        ↓      ↓ 
 Tablet Digitizing Raster Digitizing Data Import  
    Import raster data        
        ↓                ↓ 
           Digitizing of figure            Import 
        ↓                         ↓  
 Editing of figure data ← Editing of figure data such as edit and append, etc. 
        ↓ 
 Data entry and editing of attributes in database 
     Design of data coding, database, the database form, use of Relational Database, etc.
 ↓ 
  Production of thematic map  
      Classification map, use of virtual layer, production of thematic map 
 ↓     
 ↓ →  → ↓ 
      Data analysis 
     Data query and display 
     Tabulation 
 ↓    Grouping by category 
     Overlay analysis 
     Buffer analysis 
     Form management 
     ↓ 
 ↓      ←     ← 
     Production of printed map 

 ↓ 
     Data Export 
     ↓ 
 ↓      ←     ← 
    Use of GeoExplorer 
 
   Fig.1.1 Flow of General Data Processing in GeoConcept 
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2 Definition and Setup of Coordinate System 
 
2.1 Map Projection in GeoConcept 
 

For the 1:5,000 topographic map for the Dakar metropolitan area, the map projection 
of UTM was adopted. The reference ellipsoid is Clarke 1880 and the same map 
projection is adopted in IIMS as shown in Table2.1. The extended Lambert projection 
is adapted as default in the GeoConcept. Therefore, these correct elements should be 
defined in GeoConcept.  If correct parameters are set up properly, it is easy to 
display geographic coordinates or convert the coordinates into another coordinate 
system.  

Note:  The ground controls of the 1:5,000 topographic map to be produced by 
DTCG uses the coordinate system adjusted in 1974.  However, those 
of the 1:50,000 topographic map uses another coordinate system based 
on the origin of Adindan. 

The procedures to setup the definition of the reference parameters in GeoConcept 
are as follows: 
(1) Edit the Standatd.gcp file in the directory of GeoConcept by using Editor or 

Word processor. 
(2) Add the following definition record to the Standard.gcp file 

 
(3) Save the Standard.gcp file. 

 

       Table2.1  Definition of Mapping System in IIMS 
    --------------------------------------------------------------- 
       Map projection:  UTM 
       Zone number:  28N 
       Reference ellipsoid:  Clarke 1880 
       Origin of coordinates:West 15 degree  North 0 degree
       Scale factor:        0.9996 

;start Senegal UTM 
 
;  Senegal(UTM) 
START SYSCOORD                      
TYPE : 1001   <= User defined Type number 
Name : Senegal UTM <= User defined Name of coordinate system 
Projection : 1             <= Map projection ( 1 mean UTM) 
Geodetic : 1    <= Reference ellipsoid,  (1 mean Clarke 1880) 
Lamda0 : -15.0  <= Latitude of the origin 
Phi0 : 0.0   <= Longitude of the origin 
X0 : 500000.0   <= X-coordinate of the origin 
Y0 : 0.0   <= Y-coordinate of the origin 
K0 : 0.9996   <= Scale factor of the origin 
END SYSCOORD                  
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2.2 Representation of Coordinates and Conversion of Map Projection 

 
The GeoConcept is able to convert or shift the original coordinates to the 
coordinates in another coordinate system automatically by using parameters in the 
defined coordinate system. 
 
(1) Representation of coordinates and conversion of projection 
 Select “WINDOWS(W)->COORDINATE(N) Ctrl+Y“ in Command bar. (See 

Fig.2.1.) 
(2) Change of unit to represent the coordinates. 
 Select an appropriate item in the represented menu. (See Fig2.2.)  
(3) Change of the map projection. 
 Select an appropriate map projection in the map projection. (See Fig2.3.) 

  (4) Or, Select “Change -> Change Map projection” in the Edit Menu. (See 
Fig.2.4.) 

 

 

 
Fig.2.2 Change of display of map 
coordinate 

 
Fig 2.1 Selection of the coordinate window 

 
Fig.2.3  Menu of map projection 

 
Fig.2.4  Edit menu of map projection 
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3.  Data Acquisition and Compilation 

 
The procedures of data acquisition proceed in the following steps: 

・ Preparation of map for data entry (data item, figure data and definition of attribute 
data. 

・ Data entry of figure data 
・ Data entry of attributes 
・ Editing of figure data with topological checking and editing of attributes. 
・ Checking of data structure 
 

There are two digitizing methods for data acquisition of figure data compilation in 
GeoConcept as follows: 

・ Digitizing using tablet digitizer 
・ Digitizing of raster data on display 

 
For the detailed digitizing method, refer to the manual of GeoConcept. 

 
 
4.  Application of raster data and data acquisition 
 

GeoConcept provides the function of importing raster data such as Bitmap, SPOT 
Viewfile, GIF, TIFF, Defense Spatio map, and GeoConcept raster.  Raster data is 
useful to display the background data and to edit the vector data in GeoConcept.  
The user can process the scanning data to the georeference data.  It is necessary to 
prepare the correspondence data on at least four points between scanning coordinates 
and map coordinates as shown in Fig. 4.1. 
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(1,1)

Point2
(4900,1)

Point3
(1,4300)

Point4
(4900,4300)

ROW

COLUMNOrigin

Coordinate of raster data

Point2
(273000m,1653000m)

Point3
(22500m,1611000m)

Point4
(273000m,1611000m)

X coordinate

Ycoordinate

Coordinate of map data

Point1
(22500m,1653000m)

Relationship of coordinate between raster data and map data

Fig. 4.1 Correspondence between scanning data 
1-8 
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The procedures to import raster data is as follows: 
 

(1) Select import command  
This is the process to import raster data into GeoConcept.  The user selects the 
raster data file. File type is as follows: Bitmap, SPOT Viewfile, GIF, TIF, 
Defence Spatio map or GeoConcept raster. 

- Select “File -> raster -> import”.  (See Fig. 4.2.) 
- Select raster data about file name and file type in the window.  (See Fig. 4.3.). 

 
(2)  Raster data entry 

This is the process to register the GCP for matching raster data. 
- Select the icon of data registration to identify GCP on windows. (See Fig. 4.4.) 
- Data entry of GCP data 

1. Click the left button for the first point on window.  (See Fig. 4.4.) 
 Raster coordinates will be registered by this click automatically. 

2. Enter the map coordinates against raster coordinates. 

 
Fig. 4.5 Registration of GCP 

Fig. 4.2 Selection of raster import Fig. 4.3 Selection of raster data 

Fig. 4.4 Graphic window of scanning data



Study on Infrastructure Information Management System of the Dakar Metropolitan Area 

Final Report (Volume IV) 1-10 

3.  Continue to the registration of GCP and complete at least four points. (See 
Fig. 4.6.) 

 
(3) Implement to calculate  

This is the process to check the registration point by calculation of the residuals 
in the table. 
If the residual error of calculation is acceptable, click OK icon. 
There are two options to process scanning data to attach the scanning data to 
GeoConcept or to rectify the scanning data. 
OK to End 

 

 
Fig. 4.7 Calculation window 

Fig. 4.6 Registration of GCP 
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5. Import and Export 
 
5.1 Import  

 
The dataset prepared by another GIS software is available to the GeoConcept. 
Import is enabled in the following formats: 
 

(1) GeoComcept files 
(2) DXF file 
(3) MIF file 
(4) Arc/INFO E00 file 
(5) Database file (Text,dBASE, Excel)  

 
 
(1) GeoConcept file 

The GeoConcept can deal with data files of Text, dBASE and Excel and model 
file. The model file includes the structures of data and the information of layer. 
There are two cases to import data. 
 
1) In the case of using the data file directly 

Import the data file in the GeoConcept after setting up the file structure. 
The file structure of features to import should be defined in advance. 

 
2) In the case of using the model file 

By using the model file, the existing data structure is updated and the data 
file is imported.  

 
(2) DXF file 

The DXF file is imported when the version of the AutoCAD is release 12.  
The CAD is available to exchange data in the CAD or GIS.  The steps to 
import are as follows: 
 
1) Define the data structure to import, which is the names of layers, 

sub-layers and fields. 
 
2) Implement to import 

Select “File -> Import”,  
Select the ASCII DXF and then input the file name. 

 
3) In the case of importing directly 
 Select the “automatic generation”, and then implement to set a suitable 

option. 
 
4) In the case of using “Custom Import”  

Select “Data -> Set up”. 
Define the class, sub-class, data structure (polygon, line, point or text) and 
layer. 
Link the connection between the layer of DXF and items to import. 
Implement to import again. 
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(3) MIF file 

The MIF is a text file used as an exchange format in MapInfo, which consists 
of figure data(.MIF) and attribute data(.MID). If MIF file created by CartaLinx 
or IDRISI32 is used, it is necessary to eliminate bugs. The process to eliminate 
bugs is shown as follows: 
 
1) File -> Import 

Select a kind of file (MIF/MID) and the file name. 
 

2) Select “Automatic Import” or “Custom Import”. 
 

3) On “Automatic Import” 
   Implement to import 
 
4) On “Custom Import” 

Link the connection between class/class of MIF and class/sub-class and 
field of GeoConcept. 

   Implement to import 
 

(4) Arc/INFO E00 file 
At first, the data structure (layer name and field) should be confirmed from 
metadata and documents. The class and sub-class should be defined in the data 
setting menu of GeoConcept. 
 
1) Implement to import, and then memorize the layer structure. 
2) Cancel to import 
3) Define the type and subtype of polygon, line, point and text including 

database fields. 
4) Implement to import E00 file again. 
 Make a linkage between layers and fields of E00 file and GeoConcept 

manually. 
 

(5) Database file 
The dBase file and Text ASCII file are able to import in the internal database 
of GeoConcept.  
The following is the example of Text ASCII file: 
 
1) Select “File -> Import update”. 
2) Select the file to import.  
 File type is dBASE or ASCII delimited TEXT. 
3) Prepare the Setup file.  
4) Implement the wizard of data integration after selecting separator and field 

names of database in the headline.  Be careful of the selection of option.  
(Refer to the manual) 
Check the preview of the file. 
Select the option of separator. 
Select the option that uses the first record as the field name. 
Select the option. The default option is avoided. 
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5) Implement to import by the link of fields among the databases 
Define the relation to class and sub-class, and then implement to import. 
Indicate an essential field. 
Set up the linkage between fields.  
Implement to Import 

 
 
5.3 Export files 

 
The GeoConcept can create the following export files: 
 
1) Data file for GeoConcept supported by the format of Text file, dBase file, excel 

file and GeoConcept model file. 
2) DXF file for AutoCAD based on release 12 
3) MIF file for MapInfo 
4) Shape file for Arc/Info and ArcView 
  

 
(1) Data file for GeoConcept 

Process as well as Import. 
 

(2) DXF file 
Process as well as import. 
1) Select the object of sub-class. 
2) Implement to export 
 Select “File→Export”, ASCII DXF and file name. 
   Check the option and implement. 
 

(3) MIF file for MapInfo 
    Process as well as import 

1) Select the object of sub-class 
2) Select “File -> Export”. 
 Change file to MIF/MID, and input the file name. 
3) Select the class and sub-class, and then implement to export if not select the 

automatic to import.  
 

Note: The coordinates of MIF file are converted to geographic coordinates 
(latitude and longitude) of WGS84 automatically. 

 
(4) Shape file for Arc/Info and ArcView 

This function sometimes does not work because it may cause bugs in the 
present version of software. See the operation manuals as detailed as possible. 
1) Select “File -> another Export -> shape” and input the file name. 
2) Select the object of class/sub-class. 
3) Select field, and then implement to export. The field name should be less 

than eight characters. 
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5.4 Another Export 
 

(1) Picture Export 
 This function is to save the screen image to a graphic file. The graphic format 

of BMP, GIF, JPG, PCX, TIFF or WMF are prepared. 
 
(2) Tiling 

The user can set a suitable size, and then divide the screen file into tiles. The 
user can make files to put on address.  

 
1) Set the size of tile (row and column). Select the format of file and directory 

to save, then click the “next”. 
2) Select “generation” option, then click the “next”. 
3) Select color, then implement to export. 
 

Tiled file has georeference information and is available for Arc/Info, 
IDRISI32, and CartaLinx. 

 
 
6. Import from existing data and its application 

 
The digital data so called croquis is used in many organizations in Senegal. The 
coordinates are not coincided with the actual geographic coordinates. The procedures 
to coincide those with the correct coordinates will be explained below. The 
coordinate value of Y-axis is shift 1000km to south. The coordinates should be 
correct. 
 
(1) In case of GeoConcept file 

1) Make an export file from the croquis file. 
 The GC model file and ASCII GC data file are produced. 
2) Edit the type number of SYSCOORD in ASCII GC file to change it to the 

defined number. 
                     Fig. 6.1  Sample of correction 

 
3) Make the new file to set the ellipsoid, map projection and unit in meter. 
4) The GC model file is exported at first, then the ASCII GC text file should be 

exported. 
5) Using the move command, the Y-coordinate should be moved 1000km to 

north.  
6) In the information of file, recalculate the domain of coordinate and then 

define the domain.  

//$FIELDS Class=HABILLAGE; Subclass=Texte d'馗helle; Kind=3.................................. 
//$SYSCOORD {Type: 901 }   <= Type901 is Syscoord number of UTM projection  
                              in this project. 
//$UNIT Distance:m 
//$FORMAT 1 
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(2) In case of DXF file 

1) Make an export file from the croquis file. 
2) Make a new file in UTM coordinate system in Senegal.  
3) Import the created DXF file. 
4) Using the move command, the Y-coordinate should be moved 1000km to 

north.  
5) In the information of file, recalculate the domain of coordinate and then 

define the domain. 
 

(3) In case of MIF file 
1) Import MIF file to IDRISI32. 
2) Confirm or revise the coordinate system in MIF file, especially LongLat and 

Degree of Georeference parameter. The coordinate system should be the 
adopted geographic coordinate system 

3) Using the “projection”, convert the geographic coordinate system to the 
UTM coordinate system. The IDRISI32 adopts WGS-84 ellipsoid as 
reference ellipsoid in default. Moreover, the unit is meter. 

4) Make an export file. 
 

Note: In operating polygon features, one line should be added to the MIF 
file as “Pen (1,2,0) “ to prevent bugs by the editor.   
Every MIF file of line data must be edited by using the bug fixed 
program “MIFLINE” as mentioned before and imported to 
GeoConcept. 

 
5) The MIF file is exported again. 

• Make a new file in WGS-84 UTM coordinate system. 
• Import the created MIF file. 
• Using the move command, the Y-coordinate should be moved 1000km to 

north. 
• Transform the coordinate system from WGS-84 to the Clarke 1880. 
• In the information of file, recalculate the domain of coordinate and then 

define the domain. 
 
 
7. Compilation of attributes using compile and query functions for database 

 
The procedure to compile attributes of the database will be described below. 

 
(1) Encode the class/sub-class of the database  

The objects to be queried in the database are encoded as follows: 
・ Click “données -> configuration”. Check and define the class/ sub-class with 

field for coding if necessary. 
・ Add the new filed to encode. 
・ Use the data query by keying the command of “CTR-F” or select “Données 

-> Chercher”. Select the object of the class / sub-class for coding. 
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・ Click “Données -> Remplir un champ Field”. 
・ Click the tab of Remplir champ in the menu of the window 
・ Select a field in the window and enter a value  
・ Click Execute. 

 
(2) Move between layers  

Moving between layers in the class/sub-class in the database is implemented by 
using the data query function. 
・ Click “the données→Configurateur” and conform the class / subclass and 

the field to be moved. 
・ Create the class / sub-class if necessary. 
・ Define the field of the class / sub-class to be moved. 
・ Use data query to select the object by keying the command of “CTR-F” or 

select “Donnees -> Chercher”.  Select the object of the class / sub-class for 
coding. 

・ Click “Donnees -> Remplir un champ Filed”. 
・ Click the tab of “Modifier Type/Sous-type” in the window. 
・ Select “Nouveau Type” and “Noveau Sous-type” by the mouse.  
 Click the icon of “Transfer des champs” and identify to link the fields of 

“Ancients champs” and “Nouveaus champs”. 
・ Click the icon of “Modifier le Type/Sous-type”. 
・ Click the icon of “Ferme”. 

 
 
8. Application and Connection of SQL/ODBC 

 
The relational database in GeoConcept can connect the external database using 
IDAPI through the ODBC driver.  Microsoft Access97 makes it easy to connect to 
access from GeoConcept. The procedure for connection between those will be 
described as follows: 
 
1) Select the command of “File→Administrateur SQL/ODBC”. 
2) Click the icon of “Nouveau” and select the connection of IDAPI in the menu. 

(See Fig. 8.1.) 
3) Select a file in the SQL/ODBC configuration window, enter the name of 

configuration SQL/ODBC, and click the icon of “creer”. (See Fig. 8.2.) 
4) Select MSACCESS in the window of “Gestionnaire utiliseé “. Click the icon of 

“Base de données“ and select the access file and click the icon of “Suvant“. (See 
Fig. 8.3.)  
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1 

 
5) The next window is displayed as “the Lien SQL/ODBC 

–Configuration-<Configuration temporaire>“. 
 Select the option of the default or the other and continue to the next. (See Fig. 8.4.) 

 
6)  Select the one table to link, and click the icon of “Configurer la table“.  
  (See Fig.8.5.). 

 
7)  Click the Existence and select the class and sub-class to link the table. 

Indicate the key field and make a field to link between MSAccess and GeoConcept. 
(See Fig. 8.6.)  Click the icon of OK. 

 
8)  Click the icon of terminate in the previous window of step 4. 
 
9)  Click OK after the new window appears to report updating. (See Fig.8.7.) 

                                                 
1 Sample figures with texts in non-French language are included for illustrative purposes 
only. The DTGC and DUA systems display all texts in French. 

 
Fig.8.1 Selection of menu and 
IDAPI1 

Fig.8.2 Entry connection name  

Fig.8.3 Selected Database 
file of MSAccess97 
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9.  Data Analysis 
 
9.1 Query and Display 
 

The queried objects are added by using a spread sheet. 
The user can extract necessary spatial information by the data query of items in the 
class /sub-class or topological data query in GeoConcept. The user can display the 
result on the display and make some documents on tabulation data in a selection list 
on the window. There are three query modules of Rechercher, Chercher and the 
Topologie chercher.  For more details, refer to the manual of GeoConcept. The 
general flowchart of data query is shown in Fig. 9.1. 

 
Fig.8.4  Selection of the 
option for connection 

 
Fig.8.5 Selection of item in 
database 

Fig.8.6 Set up the linkage of 
database fields through key 
field 

 
Fig.8.7  Finish to set up and execution 
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Examination of selection of data query commands from Rechercher, Chercher and the topologie 
chercher. 
 ↓        → Query of the string 
Setup of the query condition          ↓ 
 Define the condition  →  Use of the existing condition  Selection of layer 
 ↓       ↓     ↓ 
Creation of Statement in SQL      Selection of the file     Input strings for 
query Definition of selection layer and field   ↓             ↓ 

Setup for the property on Display     ↓         Execution of query 
 ↓    ←                ↓ 
 Selection topological query  → Set up the condition 
 ↓    Definition and editing of the statement for SQL  
 ↓       ↓ 
 Selection of an option such as legend creation, etc. ← 
 ↓ 
 Selection of ‘save the condition’ 
 ↓              ↓ 
 Execution of data query 
 ↓    ←       ←         ← 
Display of the queried object and tabulation, and data utilization 
・Highlight of the object, 
・Confirmation of the location on display, 
・Display in Global view 
・Tabulation of results, data analysis and production of thematic map 
 

     Fig.9.1 Flowchart of query and display 
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9.2 Tabulation  
 

The memory data of a selected object in data query will be transferred to the 
selection list window in GeoConcept. (See Fig. 9.2.1.) The user can use these data 
for tabulation of the field data. In addition, a presentation material will be made for 
the spatial data analysis.  
 
The selection window is one of the unique modules in GeoConcept and plays a role 
to manage the same function as the clipboard in Windows NT. At the same time as 
the query is implemented, the contents will be displayed on the selection list 
window.(See Fig.9.2.2.)  Refer to the manual for more details. 
 

  
For example, tabulation of data is set as follows: 

 
・ Set up the configuration of display environment to the selection list in the menu 

of the field setup. (See Fig. 9.2.3.) 
・ Click the icon of “the army knife” in the selection window. 
・ The user sets up the field to display in the selection list by clicking the tab of 

“the apparence”. 
・ Click the tab of “Rupture finale”. 
・ Set up the sum of data in the selection list. (See Fig. 9.2.4.) 
・ Click the tab of “Rupture finale”. 
・ Click the “Afficher la rupture finale in Affichange”. 
・ Select the display position of the record at the top “En haut” or the last “EN bas” 

in the menu of “Affichange”. 
・ Select the timing to calculate the tabular data by clicking the option of “Calculer 

a chanque in Calcul”. 
・ Select the display style of “Gras” or “Italique” in “Apparance”. 
・ Click OK. 
 
Calculation in the selection list 
・ Pull down the field to sum and select the calculation item. 
・ Result will be displayed in the window.(See Fig.9.2.5.) 

  
     Fig. 9.2.1 Selection list window          Fig.9.2.2 The icon of selection list 
                                                  window 
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    Fig.9.2.3 Set up the configuration          Fig.9.2.4 Set up the sum of data 

 

 
                      Fig.9.2.5 Result of tabulation in the window  
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10. Preparation of Thematic Map Using Virtual Layer 
 

GeoConcept can make the virtual layer to create the several virtual layers to add 
circle charts, bar charts, labels and symbols related to a thematic maps.  
These modules make it easy to get the statistic graph, label and symbol classified 
layer on the thematic map. (See Fig. 10.1.) 
The fundamental oreration of all modules is the same. For more details, refer to the 
manual. The general operation to use the virtual layer of thematic maps is as follows : 
 
・Select the thematic map for display. (See Fig. 10.1.) 

 ・Click the icon to add a layer, and select the type of the virtual layer to be created. 
 ・Select the class and sub-class as the object. 
 ・Input the name of the virtual layer. 
 ・Click OK at the end of setup. 

 
The procedures to get the bar chart in the virtual layer are as follows : 
・Select thematic maps for display. (See Fig. 10.2.) 
・Click the check mark at the top of the terget field in the field selection. (See Fig. 

10.3.) 
・Set up a type and color. 
・Set up the width and thickness to display properly. 

 
In the case of coincidence between the field value and the presetted size of bar, the 
following operation is necessaary. (See Fig. 10.4.) 
・Click the icon of ?. This sets up the range of the minimun and maxmum values. 
・Enter the size of bar to manage the graph. 

 
Fig.10.1 The menu of Virtual Layer        Fig.10.2 Selection from View window 

                 
   Fig.10.3 Select the field              Fig.10.3 Setup the value  
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11. Topological analysis 

 
The topological analysis is the same as polygon overlay.  This function is used to 
make the new object that is common or a total area between two or more polygons. 
The following is the general operation (see Fig. 11.1): 

 
 
 
 

 

 Definition and selection of topology operation 
 ・Set up the result layer 

・Define the attribute item for extraction such as data structure, data field and its 
attribute. 

 ・Select the option of overlay from intersection, left polygon, right polygon. 
  ↓ 
 Implementation of the operation 
 ・Select the first object (possible to use the data query). 
  ↓ 
 ・Select the second object (possible to use the data query). 
  ↓ 
 Select the option (Intersection, left polygon, right polygon). 
  ↓ 
 Select the output layer of the class and sub-class. 
  ↓ 
 Select the option. 
  ↓ 
 Definition of the linkage of attribute field between input and output. 
  ↓ 
 Implementation 
  ↓ 
 The result is used for:  

・ Display of thematic map 
・ Tabulation 
・ Map print 

 
   Fig.11.1 Flowchart of topological operation 



Study on Infrastructure Information Management System of the Dakar Metropolitan Area 

Final Report (Volume IV) 1-24 

 
12.  Grouping 

 
The grouping is used to unify two or more objects and make a new object. The 
equal value is unified to each other according to the indication of the essential field. 
Refer to the manual for more detailed operation. The next will be explained as the 
example of the procedures to make a grouping of education facilities according to 
the kinds and names in the public facilities. 
・ Select the object by the data query of education facilities in public facilities. 
・ Select “Topology -> Grouping” in the menu bar. 
・ Set the selected object of education facilities in the window including the 

class/sub-class. 
・ Set the key field. 
・ Set the result object to get the operation result. 
・ Click Next (“Survant”). 
・ Reconfirm and link the relation between fields one by one. 

・ Click OK at the end of setup. (See Fig. 12.1) 
 

 

  
   Selection of object and parameters    Setup the connection between field  
  

            
                   Fig. 12.1 Result of Grouping operation 
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13. Buffering Analysis 

 
The buffering analysis is used to evaluate the accessibility of the object in GIS 
according to the purpose of the spatial analysis and the flowchart of its application. 
The user sets up the layer and the extraction conditions such as the purpose for data 
analysis, the distance of the buffer, etc. The buffer area of figure will be used for 
data analysis. Data analysis uses the buffering result and the presentation material is 
produced by the topological operation and the selection list window in GeoConcept. 
Refer to the manual for more detail. The procedures to operate are shown in 
Fig.13.1. 

 

Examination of buffer analysis as targeted 
 
Definition of the buffer, and its area and option. 
 Definition of the resulting layer such as layer name and attribute field 
  ↓ 
 Selection of object for buffer analysis by selection of a figure by mouse or by data query. 
 
  ↓ 
 Execution of buffer command 
  ↓ 
 Data input of buffer parameters of the distance and its option. 
  ↓ 
 Selection of result layer 
  ↓ 
 Execution of buffer analysis 
  ↓ 
 Utilization of result 

・Display of thematic map 
・Tabulation  
・Printout 

 
    Fig.13.1 Flowchart of buffer analysis 
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14. Document Management 

 
The GeoConcept has modules to represent documents and to update them by the 
spreadsheet of the database. This function is useful to manage the facilities. The IIMS 
can manage any kinds of data using document forms. Document forms can be 
displayed on the window using the query function or the represent attribute function.  
The procedures to use document forms are shown as follows: 
  
・Layout of the form 

1.  Select a display field in the form. 
Select “Donneés -> Confiulateur” and click the tab of “Fiche” to set up the 
fields to be able to use in the form. 
 

2.  Design of the form 
Select the object and enter “CTR-I“.  
Design the layout of the form by clicking the icon for layout. 

 
・Usage of the form 

The form will be displayed by the mouse operation as follows: 
Double click the object. 
Key in the command of “CTR-I“ or double click in the selection list window 
After selecting the object by the data query, select the form by the mouse or 
otherwise: 

 
                        Fig.14.1 Example of the form 
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15. Map making 

 
Using the module of map making, the thematic map and the evaluation map can be 
outputted. 
The procedures of how to make the legends of map as a sample are shown in 
Fig.15.1. 
 
1) Prepare for map making. 
 Select a map scale and set it up. 
 Define lines and color in query option or virtual layer 
 Using the property to represent legend, compile the legend. 
2) Design the layout 
 Set the extent to cover a sheet, the legend, the direction, scale and comments. 
3) Print maps 
 Select the output device and printing paper. 
 
 

Preparation for map making 
・Selection of map scale, printing area and paper size. 
 ↓ 
・Definition and Creation of the legend  
 The legend is prepared by the option of the query, or the classification module 
   in “Données-> Creer une classification“ , or the virtual layer.  
 ↓ 
・Define the properties of color in the query or the property of the virtual layer. 
 ↓ 
・Editing of Legend 
      Select “Fenetres->Legend or CTR-Y“. Edit the property in the legend. 
 ↓ 
・Consider the printing area and map scale, and the design of printing. 
 
・The design of map layout  
・Layout the map making area, legend, the symbol of north, scale bar, 
  annotation data, Logo, etc. 

  ・Save the layout 
  ↓ 
・Implement to print 
 ・Selection of output device and the size of paper 
 
         Fig.15.1 Flowchart of map making 
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16. Application for GeoXplorer 

 
GeoXplorer is the object of GeoConcept for use in the application of MSWord, 
MSExcel, MSAccess and Power Point in the Microsoft office software. GeoXplorer 
provides some convenient display modules to manage to display, to select the object 
and to refer to the data properties. Therefore, the user can use these good functions 
for their data management of GIS data and his presentation tool. 
 
This object of GeoXplorer must be installed from the installing disk of GeoConcept 
by the system administrator. Here is the introduction of the example of GeoXplorer in 
MSExcel.  (See Fig. 16.1). 
 

 
 
 
 
 
 
 
 
 
 
 
 

(1) Open the new file in Excel of Microsoft Office. 
(2) Insert the object of GeoXplore. 

-1 Move the cursor to the point to insert. 
-2  Insert the object of GeoXplorer and manage it.（See Fig. 16.2.） 

 
 
 
 
 
 
 
 
 

 
   Fig.16.1 Example of GeoXplorer 

    
Fig. 16.2 Insert of the object 
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(3) The design layout 

To design the form, layout the object of GeoConcept, title and some annotations. 
If necessary to change the position of the object, select 
“Affichange->Barresdéoutlis->Commandes” in the menu bar of Excel, and click 
the icon of “Mode Création” (see Fig. 16.3) and implement to layout. Drag and 
drop at the corner of the object by the mouse. Click the icon of “Mode Création” 
again and finish to edit.  

 
(4) Set up the GeoConcept data 

Move the cursor to set up the configuration of GeoConcept. 
Click the right button and select the data file of GeoConcept. (See Fig. 16.4.) 

  
Refer to the manual for the detail of GeoXplorer as shown in Fig. 16.5. 
Main functions are as follows: 
・Open a GeoConcept file(“Ouvrir une carte”). 
・Mouse mode(”Modes souris”) 
・Rectangle selection: Selection of object by rectangle area 
・Distance selection:  Selection of object by radius from cursor.  

(See Fig. 16.6.) 
・Grabber: PAN of GeoConcept 

file 
・Zoom +: Zoom in 
・Zoom - : zoom out 
・View tab: Selection of View 

tab in GeoConcept file 
Visibilités 
・View position: Position 
・Full map: Fit data on Map 

     
  Fig. 16.3 Design of layout            Fig. 16.4 Selection of GeoConcept file 

 
    Fig.16.5 Menu of GeoXplorer 
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frame 
・Distance: 

・Info BOX Mini fiche 
・Mode selection of “Active” or “Inactive”: Selection mode to refer data property 

of object data 
・Set up: Set up the configuration to display data property 
・Information 
・Display of the property selected object by Rectangle selection and Distance 

selection. (See Fig. 16.7.) 

 

 

 
   Fig.16.6 Selection of the object by the circle 

  
  Fig. 16.7 Information of the attribute 
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17.  Bugs in MIF file 
 
17.1  Bugs in MIF file in Importing 

 
The study team found two problems in the field survey. 
Although GeoConcept supports importing MIF file, the export file of MIF file in 
Cartalinx and IDRISI32 causes bugs in importing a file in GeoConcept. If this file 
is produced in MapInfo, there is no problem. Therefore, it is necessary to fix this 
bug to modify the data structure. 
 
(1) In the case of LINE data in MIF file 

BUG:  All of the data can not be imported to GeoConcept. 
Solution: This data needs to use the bug fix program ‘MIFLINE.exe’ in the 
holder of e:∖ cprg.exe in PC. This program modifies the data structure of the 
MIF file in Cartalinx and IDRISI32.  The operation is as follow: 
- Open the MSDOS WINDOW. 
- Copy MIF file to the holder of the program file e:∖ cprg. 
- Execute MIFLINE 
- The user enters only the input file name and the output file name. 
- Copy and overwrite the output MIF file. 
- Import MIF file into GeoConcept 

 
(2) In case of Polygon data 

BUG: The last polygon can not be imported into the GeoConcept.  
Solution: Use editor and Edit MIF file as follows: 
- Open the MIF file in the NOTE PAD, MSWord or other editor. 
- Move to the end of the MIF file. 
- Insert the following record at the end of file. 

 Pen  ( 1,  2,  0 ) 
- Save the MIF file. 
- Import this MIF file to GeoConcept. 

 
17.2  Bugs in MIF file in Exporting 

 
BUG:  The export file of the MIF file in GeoConcept causes the problem when it 
is imported in CartaLinx and IDRISI32.  It causes an error and stops processing. 
There is no problem when using MapInfo.     
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Solution: 
The bug fix method is as follows: 
(1) Modification of data structure of MIF file 

・ Open the MIF file by NOTEPAD or MSWord or other editor. 
・ Insert the following line at the third line. 
  Delimiter ”,” 
・ Save the MIF file. 
 

(2) Modification of data structure of MID file 
 Change the data format to CSV format (  ，delimiter) in MSExcel. 

・ Open MID file in Excel. 
・ File types are all and select MIF file. 
・ The option is selected to tab delimiter and space delimiter. 
・ Save as CSV text and overwrite the file. 

 
 
17.3 The fact of Exporting File of MIF in GeoConcept 

 
The MIF file is converted to the decimal degree of longitude/latitude in WGS 84 
automatically. When the client user imports this data in the GIS software, it is 
necessary to convert the map projection. This is not a problem. The user must 
know the data status of the MIF file in GeoConcept.  
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TOPIC 1. Digitizing of scanning data 
 
Raster digitizing is a useful mapping module to acquire the geographic feature on the 
scanning data with the georeference data. There are two data sources for digitizing the 
scanning data as follows: 
 
(1) Analog map including paper map overlay map, traced map, etc. 

The data needs to be converted from the analog to the digital data by a scanner 
before digitizing. This data must be processed to provide the georeference. 

 
(2) Digital data with the georeference including map imagery, orthophoto, satellite 

imagery. 
The data includes raster data of GIS data, which provides the georeference, and the 
user can digitize GIS data on display directly. 
 
There are three methods to digitize raster data on display as follows: 
1) CartaLinx 
2) GeoConcept 
3) Arc/Info 
 
For the detailed operation, refer to the manual of the software. 

 
Note:  Raster digitizing is easy to get vector data. This data needs image processing of 

scanning data. On the other hand, the GIS data can be acquired effectively using a 
tablet digitizer. The choice of Raster digitizing or Tablet digitizing must be 
decided by the user who considers the volume and working step properly. Raster 
process needs a sufficient capacity of CPU and RAM memory to get a good 
performance. 

 
The procedures to process the raster data will be described below: 
 
1. Data acquisition of scanning data 

 
(1) Preparation of map for scanning  

The following is the key points to work effectively before using a scanner. 
・ Items in the original map must be clear and identified to be digitized on 

scanning data. 
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・ In case that the map conditions are poor in quality, make an overlay using 

polyestel base or tracing paper including the necessary items and GCP as 
mentioned in the next step. 
Complete the preparation for the scanning. 

・ Arrangement of map coordinates at GCP on map 
   Reconfirmation of GCP and check the map coordinates. 

 
(2) Scanning 

Process the raster data by a scanner. It is necessary to define the resolution to 
keep the precision of the original map and to obtain the necessary data size to get 
the suitable performance in digitizing. 

 
 
2. Georeference data in the case of IDRISI32 

 
Scanning data must be converted to the geographic imagery. The procedures will be as 
follows: 
 
(1) Import scanning data. 
 Scanning data is imported by the import command. 
 
(2) Measure the GCP on raster data using resample command. 
 To make the file for correspondence between the scanning data and the map data, 

measure the scanning coordinate on display. GCP must be taken in consideration 
with the balance of the selected point on map. The number of GCP points 
depends on the precise of mapping transformation. 

 In the case of linear transformation, at least four points are necessary to be 
selected. In the case of quadratic, at least six points are necessary. 

 The correspondence file is needed in IDRISI32 and CartaLinx for Resample 
command. 

 
(3) Creation of the correspondence file 

Use edit command in IDRSI32. 
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(4) Geometric correction 

Confirm the range of area at the X and Y coordinates to process data. 
The resolution for re-sampling data must be considered by the user. 
Implement to the resample command. 
 

(5) Convert the available image format from the image file in IDRISI32. 
There are several choices in IDRISI32 as follows: 
To CarltaLinx: IDRISI raster file, JPG, TIFF and BMP are available.  
To GeoConcept: TIIFF and BMP are available  
To ArcInfo: Eadas file of LAN and GIS, TIFF and BMP are available. 

 
 
3. In case of CartaLinx 

 
CaraLinx can process the IDRISI32 raster data directly. The correspondence file is 
used directly in the Resample command.  At the same time, the scanning data is 
imported automatically when the georeference data is provided. 

 
 

   Example of data format of the correspondence file. 
12       <=   Number of GCP 
1208  10302  253000   1627000   <=   Pair of xy on scan data and XY 
2781  10260  253000   1628000 
4360  10227  253000   1629000 
5932  10190  253000   1630000 
1132  7092   255000   1627000 
2704  7112   255000   1628000 
4283  7077   255000   1629000 
5856  7044   255000   1630000 
1017  2436   258000   1627000 
2588  2394   258000   1628000 
4166  2360   258000   1629000 
5741  2324   258000   1630000 
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TOPIC 2  Data issues of import and export in GeoConcept 
 
1. Import and Export in GeoConcept 
 

There are several methods to exchange data for importing and exporting in 
GeoConcept among the other GIS software in IIMS as follows: 
 - 1  GeoConcept export format 
 - 2  DXF format 
 - 3  MIF format 
 - 4  Shape format 

 
 
2. The problem of MIF file in GeoConcept about data importing 

 
MIF, socalled MapInfo Inter exchange Format, is a useful data format for data 
exchange against the relevant GIS software in GeoConcept. If the user holds the 
MapInfo software, there is no problem about data conversion. However, there are 
some data problems if no MapInfo is available. Here is the solution to this problem in 
IIMS. IIMS already installed in the software of CartaLinx and Idrisi32.  The 
problem and the solution of the MIF file in IIMS will be described below.  

 
2.1 Problem of MIF File in Idrisi32 and CartaLinx 
 There are two problems in the software that the study team found at the present. 
 

(1) Problem of polygon  
 Problem:  Missing of the last polygon data in importing to GeoConcept. 
 If the user found this problem, it is necessary to edit data file as follows: 

○ Solution 1:  Editing method by editor. 
            This method is proposed to import data every time. 
  Use the NOTE PAD or MSWord or other editor to edit MIF file. 
  Open MIF file. 

 Insert the next line at the end of file: Pen ( 1, 2, 0 ) 
  Save MIF file. 
  Import MIF fill-in GeoConcept. 

◎ Solution2:  Use MapInfo 
MIF file in Idrisi32 or CartaLinix is imported in MapInfo, and MapInfo 
makes an export file of MIF properly. 
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△ Solution 3:  Use Catralinx 
One polygon file should be appended to the adjacent polygon missing in 
the CartaLinx and process the topology of polygon. 

 Make an export file of MIF again. 
 Import MIF file to GeoConcept 

 
2.2  Problem of line data of MIF file in Idrisi32 and CartaLinx 

 
Problem:  Line data of MIF file in Idrisi32 and CartaLinx is not imported to 
GeoConcept. 
This causes by the data structure between the software’s. Data position will be 
displaced to the following structure as shown below. 

 
 
 
 
 
    
 
 
 

  MIF in Idrisi32 and CartaLinx    MIF in MapInfo 
 

 Solution 1:  Use the bug fix program of MIFLINE.exe. 
Before processing MIFLINE, edit the space in the definition of the character in the 
header part of MIF file by using editor or MSWord.  Delete the space between the 
character and ( ) shown in the below. 

 

Original MIF file 
 
PLINE 
5 
xxxxx   xxxxxx 
xxxxx   xxxxxx 
xxxxx   xxxxxx 
xxxxx   xxxxxx 
xxxxx   xxxxxx 

Corrected MIF file 
PLINE 5 
xxxxx   xxxxxx 
xxxxx   xxxxxx 
xxxxx   xxxxxx 
xxxxx   xxxxxx 
xxxxx   xxxxxx 
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The preparation of MIFLINE.exe is as follows: 
-1 Open the MSDOS window. 
-2 Copy MIF file to the program holder ‘ E:¥Cprg in PC. 
-3 Execute the bug fix program MIFLINE.EXE.  
-4 Enter the input file name of MIF file. 
-5 Enter the output file name of MIF file. 
-6 Copy and overwrite the existing MIF file. 
-7 Import MIF files to GeoConcept. 
 
Solution2:  Use MapInfo to import MIF file to MapInfo and make an export MIF 

file again. 
 

Solution 3:  Manual editing against a data problem by Editor. 
Open MIF file by editor. 
Delete the carriage return after PLINE in the MIF file manually. 
Save MIF file. 
Import MIF file to GeoConcept. 

 
 

Version 3 
Charset "WindowsLatin1" 
Delimiter "," 
CoordSys Nonearth 
    Units "m" 
    Bounds (227543.131000,1620562.700000)(258188.000000,1639480.631000) 
Columns 9 
  ArcID integer 
  ArcType char  (20)  <= delete the space between char and (20) 
  FromNode integer 
  ToNode integer 
  LeftPoly integer 
  RightPoly integer 
  Length float 
  NumericUserId integer 
  TextUserId char  (50)  <= delete the space between char and (50) 
Data 
Pline   <= This line and the next line will be modified by 
 19                 program autoｍｍｍｍatically or manual editing 
 2.33835142000000E+0005  1.62822576000000E+0006 
 2.34013933000000E+0005  1.62833003500000E+0006 
 2.34340422000000E+0005  1.62849570600000E+0006 
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Data issues of Export File of MIF in GeoConcept 
 
3.1 Reference Unit in MIF File 

 
The exporting file of MIF in GeoConcept is converted automatically to the decimal 
degree of longitude/latitude in WGS 84. When the user imports this data to 
GeoConcept again, this data in the client software must be converted to the different 
projection. This is not a problem.  If the user holds the MapInfo, there is no 
problem. The user can import MIF file to MapInfo and make an export file based on 
the reference unit of meter in MapInfo again.  The MIF data using IDRISI32 and 
CartaLinx in IIMS will be described below. 

 
(1) Import MIF file to IDRISI32 

-1 Import MIF files in IDRISI32. 
-2 Confirm the contents of the map projection in metadata module. 
   Reconfirm these parameters as follows: 
 Map unit is LatLong. 
 Distance unit of map is Degree. 
-3 Transform the imported data from Lat/Long to Senegal UTM-28N by using 

Project command. Senegal UTM-28n is already preset in the IIMS.  
-4 Make an export MIF file. 
-5 Export data to GeoConcept. 

 
 

(2) Import MIF file to CartaLinx 
-1 Import MIF file in CartaLinx. 
-2 Confirm and edit the map projection in the Georeference of the Preference 

module. 
  Reconfirm these parameters as follows: 
 Map unit is LatLong. 
 Distance unit of map is Degree. 
-3 Implement to Project command 
  Select the UTM projection in Senegal.(See 

Fig.3.2.) 
-4 Make an export file after modified data. 
-5 Import MIF file to GeoConcept. 

 
3.2 Bugs of MIF file in exporting 
   

BUG:  The export file of MIF file in GeoConcept causes the problem when 
importing it in CartaLinx and Idrisi32. It causes errors and it stops processing. 
Although there is no problem when using MapInfo, the software of the third party 
has the problem.  

 

 
Fig.3.2 Selection of map 
projection 
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  Solution: 
The bug fix method is as follows: 
(1) Modification of data structure of MIF file 
・ Open MIF file by NOTEPAD or MSWord or other editor. 
・ Insert the following line at the third line. 
  Delimiter “ ，” 
・ Save MIF file. 
 

(2) Modification of data structure of MID file 
Change the data format to CSV format ( “ ，” : delimiter) by this operation. 
・ Open MID file as the text file in MSExcel. 
・ Change the file types from the default to all and select MID file. 
・ The option is selected to tab delimiter and space delimiter. 
・ Confirm the imported properly in Excel. 
・ Save as CSV text file and overwrite the file. 

 
 
4. Data Conversion of Existing Digital Data to croqis of GeoConcept 
 

Croquis data is widely used in DTGC, DUA and the related agencies in Senegal. It is 
said that the map coordinates do not correspond to the coordinates of 1:5,000 map.  
How to adjust the existing data into the map of 1:5,000 scale in DTGC and the spatial 
data infrastructure of the project will be explained below. 
 
The present croquis data in DTGC and DUA are as follows: 
The X coordinate of croquis coincides with that in the 1:5,000 map, and the Y 
coordinate of that is shifted about 1,000,000 meters along the Y-axis. Therefore, this 
data doesn’t coincide with the 1:5,000 topographic map. In addition, the map 
projection in GeoConcept is used for the expanded Lambert II in French coordinates, 
so that nobody can process to transform GeoConcept data to WGS84 or the other 
map projection.  The map projection of the existing croquis data must be modified 
to adapt to Senegal UTM data.  The following is the conversion method of exiting 
data: 

 
(1) In case of the usage of GeoConcept exchange format and DXF file 

An export file of all the croquis is created in the present data condition. 
Create the new GeoConcept file based on the map projection of Senegal UTM. 
Import all of DXF file to GeoConcept. 
 
Select all the data by the query or “CTRL+A“command. 
Select the module of transform module and Shift the 1,000,000-meters along 
Y-axis. 
Enter the distance of 1,000,000 meters against Y-axis and Execute. 
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(2) Change the definition of data area in the module of file menu. 

Select “File-> Information”. 
Calculate the data area. 
Update the information. 

 
(3) In case of GeoConcept exchange format 

-1 Create the export file on GeoConcept. 
GC model file and ASCII GC TEXT file are exported by the user. 

-2 Edit the number of SysCoord in ASCII GC TEXT file by editor according 
the preset number of Senegal UTM. 

 

 
-3 Create the new file that is defined as the Senegal UTM-28N and the 

reference unit of the centimeter. 
-4 Import GC Model file and ASCII GC TEXT file. 
-5 Select all the objects and shift the distance about 1000 kilometers along the 

Y-axis by transform. 
-6 Define the file information to set up the area. 
 

 
(4) In case of DXF 

-1 Create all DXF files in each class / sub-class. 
-2 Create the new file that is defined as the Senegal UTM-28N and the 

reference unit of the centimeter. 
-3 Import DXF file and ASCII GC TEXT file. 
-4 Select all the objects and shift the distance about 1000 kilometers along the 

Y-axis by transform. 
-5 Define the file information to setup the area. 

 

   Example of the editing 
--------------------------------------------------------------------------------------------------------------- 
//$FIELDS Class=HABILLAGE; Subclass=Texte d'馗helle; Kind=3 
//$SYSCOORD {Type: 901 } <= Type901 is Senegal UTM in the configuration file in IIMS. 
//$UNIT Distance:m 
//$FORMAT 1 
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6. Issue of Difference in Keyboard Type and Unit 
 
The French type of keyboard can treat the special characters and the unit is different 
from the American standard such as period ( . ), comma ( , ), semi-colon ( ; ),  
colon( : ) and etc. 
When the user treats French special characters from a French type keyboard in 
CartaLinx and IDRISI32 made in the USA, there are some problems to unable the 
use of French characters in the software.  
The French font package of IDIRISI32 and Cartalinx is still not released to the 
market. The previous version provides the French font package. In addition, it is 
necessary to change the unit environment in PC as mentioned above. GeoConcept is 
made in French.  
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Reference:  Data Exchange in IIMS 
 
IIMS uses the GIS software and the mapping software including GeoConcept, IDRISI32, 
CartaLinx and Arc/Info.  The data exchange between the software and the data format in 
importing and exporting is shown in Fig.1. Though the available format is different in 
software, it is supposed to use the following data exchange format in IIMS frequently: 
 

(1) MIF format 
MIF file in MapInfo can be imported and exported among GeoConcept, IDRISI32, 
CartaLinx directly.  Pay attention to the bugs in MIF as mentioned before. 

 
  (2) SHP format 

The SHP format in ArcView and Arc/Info is exported by GeoConcept and is 
imported and exported between IDRISI32 and CartaLinx directly. 

  
  (3) DXF format 

The DXF file is available for all of the software. However, data exchange is in the 
level of the release 12 of DXF file.  All of the layer data must be prepared for the 
DXF files in use. 

      In case of Arc/Info: 
Import to the DXF file and process the topological data. 
Convert it to the Ungenerate File or shape the file. 
Import to IDRISI32 or CartaLinx. 

In case of IDRISI32: 
Import it to IDRISI32. 
Import the IDRISI32 format in CartaLinx or use the other available export 
format between IDRISI32 and CartaLinx. 

 
(4) Other format 

Any other format is imported and exported to CartaLinx or IDRSI32 via the 
available format in other GIS software. 
In ArcInfo, there is a text format of the Generate File and the Ungenerate file. 
These file formats are available for IDRISI32 and CartaLinx. These files can be 
treated as line data, point data and polygon data of both combinations in IDRISI32 
and CartaLinx. The unregenerate and generate file of polygon data must be 
separated from the line data and point data of the label of polygon individually. 
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The point data has the label of the attribute data and key field. This can be linked 
to the relational database of Text file or MSAccess in IDRISI32 or CartaLinx. 
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Figure1 Data compatibility of vector data format and raster data in IIMS 
 
Format / software   Arc/Info  GeoConcept  IDRISI32   CartaLinx 
Vector data  
  ArcInfo Exchange format E00File   :  E00        → E00 
  Shape file           :  Shp         ← Shp 
       :  Shp        ←→   Shp      ←→  Shp 
  Generate File     :  Generate file  ←→   Genarate file ←→  Generate File 
  DXF file      :  DXF      ←→ DXF     ←→ DXF 
  MIF file      :     MIF    ←→ MIF      ←→   MIF 
  Idrisi Vector file        :       Idrisi VectorFile    ←→   Idrisi Vector File 
 
Raster data 
  TIFF file      :   ○   ○   ○      ○ 
  BMP      :   ○   ○   ○      ○ 
  JPG       :   ○   ○   ○      ○ 
  ERDAS(LAN,GIS)     :   ○      ○  
  IDRISI RASTER     :        ○      ○ 
 
Database 
  Text          :   ○   ○   ○      ○ 
  dBASE(Shapefile)        :   ○   ○   ○      ○ 
  MSAccess      :   ○ *ODBC  ○ *ODBC  ○      ○ 
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Table1 Data issues and solution of MIF file among GeoConcept , IDRISI32 and CaltaLinx in IIMS 
 

 

 

MIF file in IDRISI32 and CaltaLinx : Issues in GeoConcept  Solution 
---------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 
Polygon    : Last polygon missing  Necessary to edit MIF file to add one line” Pen (1,2,0)”  at the end  
                                                            of file.  
 
Line     : Impossible to import  Necessary to process the batch process of the modification data 
                                                            structure by MIFLINE      
 
Point     : no problem   Nothing 
 
ALL MIF file    :     Use MapInfo to make export file.  

MIF file in GeoConcept   Issues in drisi32, CartaLinx Solution 
--------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 
Polygon, line, point   : Impossible to import  Necessary to edit MIF file and MID file as follows: 
          1. Insert one line at the third line as follows: 
            Delimiter is ‘ , ‘; 
 
                                                            2. Edit MID file from Tab delimited ASCII TEXT to CSV of 
                                                              Delimiter kama ASCII TEXT by using EXCEL 
 
All MIF file    :     Use MapInfo to make export file 
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